
 
Version 1.0

Users Manual

(C) 1993, SavageWare



This manual was produced using Doc-To-Help®, by WexTech Systems, Inc.

WexTech Systems, Inc.
310 Madison Avenue, Suite 905

New York, NY 10017
(212) 949-9595



 

Contents

µOverview 1
Introduction...............................................................................................................................1

Getting Started 3
Unpacking and moving in........................................................................................................3

What's in this package? 3
Where does the furniture go? 3
System requirements 4

Your first sheet 5
Going from soft to hard-copy..................................................................................................5

The main form 6
Selecting a drive 7
Divider Tabs 8
Printing your labels 8
Preparing for the next sheet of labels 8
Exiting Laser LabelMate 9

Navigating 10
Using the menus......................................................................................................................10

The File menu 10
Disk Label menu 11
Tabs menu 12
Help menu 13

License Information 15
Unregistered version...............................................................................................................15
Registered version...................................................................................................................15

Miscellaneous 17
Technical Support...................................................................................................................17
Feature suggestions.................................................................................................................17
Network/multiple-copy orders..............................................................................................18

Glossary 19
Terms used in the manual......................................................................................................19

Index 21

Contents§  ·  i



Navigating§  ·  ii



Overview

Introduction
Long ago, in the era of dot-matrix printers, it was easy to print the directory list of 
a floppy disk on an adhesive label.  Now the text may not always have been legible
(especially if you had a 9-pin printer), but it worked, and it was easier than popping
the disk into the drive and using DOS to get a directory of the files.

But if you have a laser printer, well, that changes everything.  All of a sudden, that 
great old labeling program no longer works because it was designed to print labels 
one at a time -- or to be more accurate, one line at a time; and as we all know, laser
printers print one page at a time.

So began the quest (and as any Monty Python fan clearly knows, the Quest is the 
Quest) for laser printer disk labels and a program that would make use of them.  
The first part was easy -- a trip to the local business/office supply store turned up a 
vast supply of Avery 5196 label stock; and though a box of these labels carried a 
hefty price tag (approximately $35), the final cost of 5.5-cents per label didn't seem
like such a big expense in the long run.

The second half of the Quest was a bit more difficult.  After looking high and low, 
under rocks and in trees, on bulletin board systems from one end of the country to 
the next, and even on a couple of commercial on-line services, things were looking 
pretty grim.

I couldn't find a program to do what I needed, so in the true spirit of a determined 
wonk (and entrepreneur), I set about to create the very tool that seemed so elusive, 
and Laser LabelMate was born.

Glossary§  ·  1



Getting Started

Unpacking and moving in
Laser LabelMate is distributed as shareware in a ZIP archive.  To install the 
program, you will need to unZIP the archive and place some of the files in specific 
places.

What's in this package?

The LABLMATE.ZIP archive contains the following files:

· LABLMATE.DOC This file (Word for Windows 2.0 format)

· LABLMATE.EXE Laser LabelMate executable

· LABLMATE.HLP Help file for use with Windows Help viewer

· LABLMATE.TXT This file (in ASCII text format)

· THREED.VBX Custom control file

Not included in the LABLMATE.ZIP archive, is VBRUN200.DLL.  This is the 
dynamic link library used by any program written in Visual Basic 2.0 for Windows;
but don't worry, you've either already got it in your \WINDOWS\SYSTEM 
directory, or can find it on the system where you downloaded this program.

Where does the furniture go?

For the most part, you can put the executable anywhere you want to (though I 
recommend the \WINDOWS directory); however, Laser LabelMate is coded to 
look for the Help file in the \WINDOWS directory.

The THREED.VBX file should be placed in the \WINDOWS\SYSTEM directory, 
though you can keep it with the executable if you prefer.  Placing this (and any 
other .VBX controls you may have) in your \WINDOWS\SYSTEM directory 
makes them available to any Visual Basic program, and reduces the chance of you 
having more than one copy of these custom controls on your disk drive.



System requirements

Laser LabelMate requires a SVGA card capable of 800-by-600 resolution, and 
displaying a minimum of 16 colors (though a 256-color display will make the 
splash screen look a whole lot nicer).

Laser LabelMate can be run from a floppy or hard drive; it's footprint is only as 
much as the executable, Help file, custom control, and .DLL require -- about one 
megabyte.

While Laser LabelMate is designed to use a laser printer, it should work on any dot
matrix printer that has the ability to feed single sheets.  Laser LabelMate has been 
tested on the HP LaserJet IV and Panasonic KX-P4410 printers, but should work on
any laser printer with a Windows driver.

Laser LabelMate was designed to use Avery 5196 label sheets.  These sheets 
contain nine 2.75"-square disk labels, and 12 divider tab labels; all of which can be 
used by the program.



Your first sheet

Going from soft to hard-copy
Hopefully, by, now, I've lost you; rather, hopefully, you'll not need to read these 
pages.  Laser LabelMate was designed to be fairly intuitive.  But just in case you're
a masochist, or the type who likes to read manuals, here goes.

The main form

 

The Laser LabelMate form resembles the Avery 5196 sheet.  You'll see nine square
boxes with rounded corners (one for each disk label), and below them, 12 smaller 
rectangles (also with rounded corners) for the divider tab labels.  Along the bottom 
of the form are four command buttons which will be explained shortly.

To prepare a label for printing, double-click on the desired disk or divider tab label 
box on the main form.  You needn't worry about starting with the first label in the 
upper left-hand corner; Laser LabelMate is designed to print on the labels you want
it to use, so no labels get wasted.  If you want to start dead in the middle, then go 
ahead; and if you're really a free spirit and get into random or geometric patterns, 
double-click in the order you like and get wild; Laser LabelMate doesn't care.  In 
fact, if you mess up, and prepare a label for a disk you don't really want to label or 
misspell that tab, then just double-click on that label again, and you can correct 
your mistake.



Selecting a drive

 

After double clicking on the drive label square or selecting the label from the Disk 
Label menu, the drive selection window will pop up over the main form.  There are
two buttons on the top of this window for choosing a drive to take a directory from;
click on one of these buttons and the file list box will appear with the contents of 
the disk's files.  (Note:  Subdirectories will not appear in the file list box, nor will 
they appear on any label printed out by Laser LabelMate.  Sorry for the 
inconvenience...)

If you have chosen the wrong drive or disk, just click on the drive button again and 
Laser LabelMate will poll the new disk or drive.

Once you're satisfied with the directory list, click on the "OK" button and Laser 
LabelMate will pop up a dialog box prompting you for the Volume Label.  You 
may enter a string of up to 50 characters to describe the disk.  This string will be 
printed on the label, and positioned so that it will rest on the top narrow edge of the
disk.

 

After entering a Volume Label, press [ENTER] and you'll be back at the main form
ready to prepare the next disk label.  The label square you just prepared will now 
contain a drawing of a floppy disk, with your Volume Label printed on it's disk 
label (Note:  Your finished label will not resemble the one pictured on the form.).  
When all nine disks appear, you're ready to print your label sheet -- though you can
print the sheet even if you haven't prepared any of the labels, but what good would 
that be?

 

After getting a directory list of a disk, the label square will change to resemble a 
floppy disk with the text of your Volume label on it.

Divider Tabs

The 12 small labels at the bottom of the Avery sheet are used for labeling dividers  
in a disk box.  Laser LabelMate will allow you to print a string of up to 12 
characters on these small labels.

To prepare a divider tab label, double-click on it, or use the Tabs menu to select the
appropriate label (Note: the Tabs menu uses hexadecimal numbering to specify tab 
numbers; therefore tab 10 is represented in the menu as Tab A, tab 11 is Tab B, 
and tab 12 is Tab C.).  A small dialogue box (similar to the one used for assigning 
Volume labels) will pop up over the main form.  Enter the desired text string and 
press [ENTER].  The text string you just entered will appear on it's label in the 
main form.

Printing your labels

Now that you have prepared all the labels you want, printing is the next step; and 
it's just as easy as preparing your label sheet.  To print out your disk labels, load the



Avery sheet into your printer's paper tray (or put it in the manual feed) and click on
the [PRINT LABELS] button at the bottom of the main form, select the Print 
option from the File menu, or press the [CTRL-P] key combination.

Laser LabelMate will send the text of your label sheet out to your printer, and using
the default printer font, will print disk label text in all caps using 6-point type; 
divider tab labels will also use the default font in upper and lower case using 12-
point type.

Preparing for the next sheet of labels

Laser LabelMate does not automatically clear out the current sheet after printing 
just in case you need to print out more copies of the same sheet (just click on the 
Print button again to print another sheet).  To clear the current sheet from memory,
click on the New Sheet button, select the New Sheet option from the File menu, or 
press the [CTRL-C] key combination; the main form will clear and you will be 
ready to begin another label sheet.

Exiting Laser LabelMate

Finished?  So soon?  Well, if you insist on going, you have three ways out.  The 
first is to click on the Exit button at the bottom of the main form; the second is to 
use the [CRTL-X] key combination; and the third, as with any other Windows 
application, is to press the [ALT-F4] key combination.



Navigating

Using the menus

The File menu

 

New Sheet [CTRL-C]XE "new sheet"§XE "clear: new sheet"§XE "resetting: new sheet"§XE
"preparing a new sheet"§

This option will clear the current sheet from memory, giving you a fresh set of 
labels and divider tabs to work with.  While you can change the contents of any one
label by double-clicking on it and going through the process of providing the 
necessary information again, using this option allows you to clear the whole sheet 
at once.

This option can also be accessed by pressing the New Sheet button at the bottom of 
the main form.

Print [CTRL-P]
If your label sheet is at a point where you are ready to turn it into hard copy, 
choosing the Print option will send the contents of the sheet to the printer.  Since 
the sheet is not cleared after printing, you can use this option again to print 
multiple copies of your label sheet.

This option can also be accessed by pressing the Print Labels button at the bottom 
of the main form.

Exit [CTRL-X]
When you're ready to close Laser LabelMate, you can choose this menu option to 
exit.  Windows provides another control for exiting an application in the form of 
the [ALT-F4] key combination.

This option can also be accessed by pressing the Exit button at the bottom of the 
main form.



Disk Label menu

 

Disk 1 through Disk 9
Choosing any of these menu items will open the Drive Selection dialogue box and 
begin the process of preparing a label for the respective disk label square.  If you 
make an error and select the wrong disk label, or accidentally poll the same disk 
twice, you can choose the menu option or double-click on the label square and 
begin the process for that label again.  Disk labels are numbered one through three 
on the first row; four through six on the second row, and seven through nine on the 
third row, all in left-to-right configuration.

The same actions can be accomplished by double-clicking on the respective disk 
label square.

Tabs menu

 

Tab 1 through Tab C
Choosing any of these menu items will open a dialogue box which will allow you 
to enter a string for a Divider Tab.  If you make an error, you can choose the menu 
option or double-click on the tab's square and re-specify a string for that tab.  
Divider Tab labels are limited to 12-characters maximum.  Tab A, B, and C in the 
menu correspond to tab's 10, 11, and 12 respectively.  The tab labels are numbered 
one through six on the first row, and seven through twelve on the second row, all in
left-to-right configuration.

The same actions can be accomplished by double-clicking on the respective 
Divider Tab label square.



Help menu

 

Contents [F1]
This option will open the Help file for Laser LabelMate.  This file should be 
located within the same directory as the program's executable.

This option may also be accessed by pressing the Help button at the bottom of the 
main form.

About
Choosing this option from the Help menu will open the About box.  You will find 
the version number and registration status on this form.  To close the About box, 
merely press any key or click the mouse once on this form.

Registration [CTRL-R]
To register your copy of Laser LabelMate, or to order additional copies, choose this
menu option, and fill out the form.  Please include your name, address and phone 
number in the appropriate boxes, and then specify the number of copies you would 
like in 3½" or 5¼" disk format.

Priority 2-day mail delivery is available for an additional charge of $3.00.  If you 
would like to have your registered copy of Laser LabelMate delivered via the 
Postal Service's 2-day Priority Mail delivery, check the box and the registration 
form will include the necessary fee.

The registration form will automatically compute the charges for your order and 
provide a total at the bottom of the form.

To complete the registration process, click on the Print button and enclose the 
printed form along with a check or money order (no cash please) payable to Savage
Systems or Peter Savas, and mail it to the address on the form.  You will receive 
your personally-registered copy of Laser LabelMate within two weeks.

 



License Information

Unregistered version
You are granted permission for unlimited use of Laser LabelMate for a period of 
30-days.  After that time has expired you are required to delete your copy or 
register if you choose to continue to use the software.

You may distribute the unregistered version of Laser LabelMate in its original 
archive.  You may not charge any fee for distribution of this program other than a 
disk copying fee not to exceed $5.00.

A considerable amount of time and effort went into developing Laser LabelMate, 
and the registration fee of $20 represents a fair price for a utility of this class.  By 
registering your copy of Laser LabelMate you enable the author (me) to continue to
revise, improve and release subsequent versions, as well as other software.

Your registration will be sincerely appreciated.

Registered version
You are granted permission to use one copy of Laser LabelMate on a single 
computer, or on multiple computers so long as that copy is not running 
simultaneously on more than one machine.

Your registered copy may not be placed on a network system  where more than one
computer has access to the program files.

You may not distribute the registered version of Laser LabelMate, or any of its 
components (including this documentation) in any way, shape or form.



Miscellaneous

Technical SupportXE "technical support"§
Laser LabelMate was designed to be easy-to-use and fairly self-explanatory.  It has 
been tested on an HP LaserJet IV and on a Panasonic KX-P4410 laser printer.   No 
guarantees of operation can be made on any other model printer, though the 
software should operate without any problem on most printers (laser and non-laser 
types) as it does not use any specialized fonts or printing techniques.

However, if you find you need technical support, the author (me) can be reached 
via the following:

· America Online:  PeterS61
· RIME:  Peter Savas
· by phone:  (801) 583-6005, evenings
or at the address on the registration/order form.

While every attempt has been made to ensure this software is bug-free, bug reports,
should they occur, can be submitted through the channels above.  These reports 
should include a description of your system hardware and software, as well as 
copies of your AUTOEXEC.BAT, CONFIG.SYS, WIN.INI and SYSTEM.INI files.
Also, please include what actions prompted the error, and indicate whether or not 
you were able to reproduce the error.

Feature suggestionsXE "feature suggestions"§
Got a feature you'd like to see in a future version of Laser LabelMate?  I'm 
interested in hearing about it!  You can send any feature requests to me through any
of the channels listed above.  Depending on the complexity of the request, you may
just see it as fast as the post office can deliver...

One of the benefits of shareware is the ability of the author to respond to the 
requests of his customers.  Your feedback is immensely valued, and I'm only too 
happy to accommodate my paying customers; so don't be shy, let me know what 
you think -- even if you don't like the program!



Network/multiple-copy ordersXE "network/multiple-copy 
orders"§XE "network orders"§XE "multiple-copy orders"§XE 
"ordering: network"§XE "ordering: more than one copy"§

If you would like to order a copy of Laser LabelMate for use on your network, or 
would like to order multiple copies, you may fill out the pricing section of the 
registration/order form by hand using the following pricing structure.

Network Multiple

Orders of 5-10 $18.00 $18.50

Orders of 10-20 $17.00 $17.50

Orders of 20-or-more $15.00 $16.00

Network copies will be distributed on a single 3½" or 5¼" diskette.  A network 
usage notice will be placed in the About box.

Multiple copies will bear each individual users' name in the About box, provided a 
list of users' names is included with the order; otherwise, the name of the person 
ordering will be used for each copy.  Multiple copy-orders will be distributed on 
individual disks; one per copy ordered, and can be provided on either size media 
(please specify this on the order form).  If your order is more than five copies, and 
you would like Priority shipping, please include $10.00.



Glossary

Terms used in the manual

Avery 5196

This label type consists of a sheet with 9 2.75" disk labels and 12 divider tab labels.
They are manufactured by Avery Dennison, 5196 being the product code number.

divider tab

A small label at the bottom of the Avery 5196 label sheet.  These labels are 
commonly used on dividers in diskette boxes to show categories by which the disks
are organized and stored.

dot-matrix

A printer type which prints one line of information at a time; as opposed to a laser 
printer which prints one page of information at a time.

laser printer

A printer type which prints one page of information at a time; as opposed to a dot-
matrix printer which prints one line of information at a time.

shareware

A type of software which allows the user to "try" the software out for a period of 
time, usually 30 days, before being asked to purchase a copy by paying a small fee 
and registering the purchase with the author.

SVGA

Super VGA graphics: A standard supporting resolutions of 640 x 480 x 256-colors 
and higher.  It is recommended that you use an 800 x 600 x 256-color setting be 
used with Laser LabelMate.

THREED.VBX

A Visual Basic custom control file used by Laser LabelMate.  Make sure this is 
placed in your WINDOWS\SYSTEM directory.

unZIP

The process of un-compressing an archive file.

VBRUN200.DLL

Run-time library used by programs written in Visual Basic 2.0.  VBRUN100.DLL 
is the run-time library used by programs written in Visual Basic 1.0.  Both libraries 
can be downloaded from bulletin boards and on-line services.  The 
VBRUN200.DLL is required for Laser LabelMate to run.

Volume Label

This is a name you want to give to the disk; for instance: "Graphics Disk #1."

ZIP

A file archive compression technology from PK Ware, Inc.  The PKZip software is 
available from most bulletin boards, and is distributed as shareware by it's author.
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